
Level TROLL® Family

Level TROLL® 100 and  
Level TROLL® 200 Operator’s Guide 

The Level TROLL 100 and 200  are rugged, accurate instruments for 
measuring pressure, level, and temperature in natural groundwater and 
surface water, as well as industrial, waste, and other installations. 

Both instruments have completely sealed bodies that contain an absolute 
(non-vented) pressure sensor, temperature sensor, real-time clock, 
microprocessor, sealed lithium battery, and internal memory.

The Level TROLL 100 is designed to hang by a backshell hanger from a 
suspension wire.  The Level TROLL 200 can utilize the backshell hanger 
or can connect to a cable for easy top-of-well RS485 communications via 
RuggedReader® handheld PC or laptop PC.  Additionally, Level TROLL 
200 cables with stripped and tinned cable ends can communicate with 
data loggers or PLC devices via RS485 or SDI-12.

Communication Components

USB or RS232 Docking Station for the Level TROLL 100 or 200•	

USB or RS232 TROLL•	 ® Com for the Level TROLL 200 only

Win-Situ•	 ® 5 control software for programming and downloading

Optional software: Win-Situ•	 ® Baro Merge™ for barometric 
compensation, Win-Situ® Mobile for the RuggedReader, Win-Situ® 
Sync to transfer downloaded data logs from a RuggedReader to a PC

Other Accessories

Level TROLL 100: suspension cable, RuggedReader handheld PC, •	
BaroTROLL® 100 for logging barometric pressure data

Level TROLL 200: suspension cable, RuggedReader•	 ® handheld 
PC, BaroTROLL® 100 for logging barometric pressure data, SDI-12 
compatible cable with bare wire uphole termination, RS485 compatible 
cable with bare wire uphole termination, or RS485 compatible cable 
with watertight cable connectors.

Level TROLL 200 Cable Suspension Kit: creates a weight-bearing loop •	
capable of suspending up to 100 lbs of cable and instrument.

Getting Started

You will need— 

Level TROLL 100 or 200 instrument•	
USB or RS232 Docking Station or TROLL Com (for Level TROLL •	
200 only). You will need RS232 models for connection to a 
RuggedReader.
In-Situ Software/Resource CD, or Internet connection •	
Desktop / laptop PC, or RuggedReader•	

Install software from the In-Situ Software CD or www.in-situ.com.A.	

Win-Situ 51.	

Click the Win-Situ 5 link and follow the instructions. •	

For a USB Docking Station, be sure to select the “Install USB Drivers” •	
option.

Win-Situ Mobile (for the RuggedReader)2.	

Click the Win-Situ Mobile link and follow the instructions to install Win-•	
Situ Software Manager (desktop component of Win-Situ Mobile). 

If running Windows•	 ® XP or earlier: Also install Microsoft® ActiveSync® 
4.5 or higher (not required for Windows Vista™).

To install Win-Situ Mobile on the RuggedReader: Connect the •	
RuggedReader to the PC via USB cable, establish a connection via 
ActiveSync, launch the Win-Situ Software Manager, click Win-Situ 
Mobile, click Install. Have your In-Situ Software License Certificate handy.

Win-Situ Baro Merge (version 1.3.1.6 or higher) 3.	

Install Baro Merge if you plan to post-correct level data to compensate •	
for barometric pressure.

Win-Situ Sync4.	

Install Win-Situ Sync if you want to •	
automatically transfer downloaded 
log files from a RuggedReader to a 
PC. 

Connect to the Docking Station B.	
(Level TROLL 100 and 200) 

Unscrew and remove the hanger •	
from the Level TROLL 100. 

Invert the instrument. Align the notch on the Level TROLL 100 body •	
with the tab on the rim of the Docking Station to ensure the pins are 
mated for communication. 

Place the Level TROLL 100 into the Docking Station. •	

Connect the docking station cable to the computer.•	

The hanger is the only removable part of the Level TROLL 100. Do 
not attempt to take the instrument apart. There are no user-
serviceable parts in the instrument body. 

Connect to the TROLL Com (Level TROLL 200 only)C.	

Connect to the TROLL Com as described in the TROLL Com •	
instruction sheet.

The TROLL Com 200 requires a minimum of 8 VDC. If you lose 
connection to your instrument, particularly over long distances, 
replace the TROLL Com 200 battery.
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Create a SiteC.	

Logged Level TROLL data are organized by the site where the data were 
logged. You will need a site when setting up a data log. Follow the steps 
below to create a new site: 

On the Data tab, click the Site Data folder (Fig. 1).•	

Select File menu > New > Site. •	

Enter a short, descriptive name—for example, a project, well, river, •	
gaging station, town, nearby landmark, etc. (max: 32 characters).  

Enter any additional options you want, then click •	 Save. 

To set the new site in the Level TROLL: Return to the Home tab, click the •	
down arrow beside the site box (Fig. 2), and select your new site. 

Set up a Data LogD.	

Click the Logging tab •	  .

Click the “New” button •	   at the bottom of the Logging tab.

The Logging Setup Wizard will prompt you through the configuration of a 
data log. For details, refer to Win-Situ’s Help menu. 

TIP: When logging Level (DTW or Surface), select the option “Set 
First Logged Reading to____” for the Level Reference.  Be sure to 

select a Scheduled start, so the log will start automatically.

TIP: When logging Depth, choose a Scheduled start, or start the 
log before disconnecting by selecting it in the Logging tab and 

clicking “Start” .

SDI-12 Wire Connections (stripped and tinned only)D.	

Black = ground•	
Red = 12 V supply line•	
Blue = serial data line•	

Remaining wires should be terminated (grounded) at the data recorder. For 
more information, refer to the Level TROLL 200 Cable instruction sheet.

RS485 Wire Connections (stripped and tinned only)E.	

Black = ground•	
Red = 12 V supply line•	
Blue = RS485 (+)•	
Green = RS485 (-)•	

Remaining wires should be terminated (grounded) at the data recorder.

Programming the Level TROLL 100

Launch the Software A.	

Start Win-Situ by double-clicking the desktop shortcut 1.	 .

Win-Situ launches at the Data tab, shown in Fig. 1.•	

When you launch for the first time, the software may ask if you 2.	
want to select a COM port. Do one of the following:

Answer Yes to the prompt, then check or change the port in the •	
Comm Settings dialog, and click OK  to close it, or
Answer No to bypass this step.•	

Win-Situ's default is COM 1. For USB communication, be sure to 
select the correct COM port. See the sidebar below.

Win-Situ asks if you want to connect to the device. If the Level 3.	
TROLL is connected to your computer as shown on page 1, 
answer Yes. 

Software connects and displays a reading of all supported 4.	
parameters in the Home tab (Fig. 2).

Set the ClockB.	

Data collection schedules depend on the device clock, shown with the 
system (PC) clock near the top of the screen when connected (Fig. 2). If 
the device clock is red, synchronize it to the system clock by clicking the 
Clock Sync button (Fig. 2).

Device  
is not  

connected

C:\Documents and Settings\[Login]\My Documents\WinSitu Data\

2 Check the 
COM port

3 Connect to the 
Level TROLL 100

Data tab

Site Data folder

Fig. 1. Win-Situ Data tab on first connection

Device is connected 

Home tab

Clock sync

Fig 2. Home tab with device readings

Site box

Which USB Port Am I Using?

When a USB Docking Station is connected, the drivers that were down-
loaded with Win-Situ 5 are installed. After installation, check which 
COM port the connected USB Docking Station is using:

Windows 2000, Windows XP:•	  Control Panel > System > 
Hardware tab > Device Manager > Ports. Click the plus sign to 
display the ports.
Windows Vista:•	  Control Panel > System > Device Manager (User 
permission required) > Ports. Click the plus sign to display the ports.

Remember the port number. You will need it to connect to the 
instrument in Win-Situ software.
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Disconnect and Deploy the InstrumentE.	

Exit the software (File menu > Exit). Remove the Level TROLL from the 
docking station or TROLL Com. Connect to the backshell hanger and wire 
or to the cable. Install the device in the field location.

TIP: A Scheduled log will start at its programmed start time only if 
the device clock is correctly set (see B on this page).

Downloading the Logged Data

Retrieve the Level TROLL 100 by pulling up the cable. Dry the •	
instrument and remove the hanger. Place the Level TROLL 100 in the 
docking station (see page 1) and establish a software connection.

For the Level TROLL 200, remove the cap from the cable and •	
attach the TROLL Com 200. Connect the TROLL Com to a PC or 
RuggedReader device and establish a software connection.

Click the Logging tab •	  and then the log. The symbol  shows 

the log is running. If the log stopped on schedule, the symbol is .

TIP:  It is not necessary to stop the log before downloading, but if 
you want the device to stop logging, press “Stop” , or suspend 

it by pressing “Pause” . Remember to resume the log if suspended!

To download, press the “Download” button •	  and select a 
download option. The log will be copied to the PC or RuggedReader.

TIP: Use Win-Situ Sync to transfer downloaded logs from a 
RuggedReader to a desktop or laptop PC running Win-Situ. This 

will assure that the logs are placed in the Win-Situ working directory. 

Pressure due to  
atmosphere + 
water column 
(measured by 

Level TROLL 100)

Water 
Level

Pressure  
due to  

water column 
(calculated by  

subtracting 
BaroTROLL  

data from  
Level TROLL 

data)

Pressure  
due to  
atmosphere 
(measured by 
BaroTROLL ) BaroTROLL 100

Level TROLL 100

Fig. 3. BaroTROLL 100 & Level TROLL 100 deployment

BaroTROLL® 100 Instrument

The BaroTROLL 100 is a special model of Level TROLL 100 that logs 
barometric pressure and temperature in air. This data can be used to 
correct the Level TROLL 100 and 200 data by compensating for barometric 
pressure effects during the course of a log. 

Note: BaroTROLL 100 instruments with serial numbers greater 
than 144621 can be used with Level TROLL 200 cables and 
TROLL Com, or the docking station.  Earlier models are 
compatible with the docking station only.

Programming the BaroTROLL 100A.	

Connect as for the Level TROLL 100.•	
Program as for the Level TROLL 100. Be sure to sync the clock! The •	
measurements can be quite far apart as long as they cover the same 
general time period as the Level TROLL 100 log. 
If the Level TROLL 100 log used a reference (“Set first logged reading •	
to”), the BaroTROLL log should start before the Level TROLL log to 
ensure barometric pressure at the time of the first reading is captured.
Disconnect, attach the hanger, and deploy suspended or lying in •	
a protected location above water level, near the submerged Level 
TROLL 100 or 200. One possibility is shown in Fig. 3. 

DO NOT submerge a BaroTROLL 100.

Download data as for the Level TROLL 100 and 200. •	

Correcting for Barometric pressure effects

As shown in Fig. 3, the Level TROLL 100 and 200 instruments measure 
all pressure forces detected by their absolute pressure sensors. These 
forces include barometric (also called atmospheric) pressure and the 
pressure of the water above the sensor. As a result, logged data will 
show the effects of changes in barometric pressure. These effects can be 
removed manually (see the technical note “Manual Barometric Correction” 
in the Downloads section of the In-Situ website). To automatically remove 
barometric pressure effects, use Win-Situ Baro Merge software. 

Using Baro Merge SoftwareA.	

You will need: 

Win-Situ Baro Merge and Win-Situ 5 installed on a desktop/laptop PC•	
One or more Level TROLL 100 logs in your Win-Situ working •	
directory
A BaroTROLL 100 log in your Win-Situ working directory covering •	
the time period of the Level TROLL 100 log(s) to be corrected

Launch Baro Merge from the desktop shortcut or the Win-Situ 5 1.	
Tools menu.

In the main window, select “Use a BaroTROLL file” for the 2.	
compensation method (Fig. 4). 

TIP: Information on the other two compensation methods may be 
found in Baro Merge Help (press F1 in Baro Merge).
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Fig 4. Baro Merge options with BaroTROLL file method selected

	Click 3.	   to select a BaroTROLL 100 log file. (Baro Merge 
displays these automatically by site when they are in the proper 
location.) 

Click the plus sign to expand the site and display the logs. •	
Check •	  the BaroTROLL 100 file you want to use, then click OK 

 . 
The main window returns to the screen with the BaroTROLL 100 4.	
log file displayed (Fig. 4). Click Next  to continue.  

Baro Merge reads and displays the values in the BaroTROLL 100 5.	
log. Edit the values if you wish, or click Next  to continue. 

TIP: For details on adding or editing values and time stamps in the 
table, see Baro Merge Help (search for “Manual Entry”) .

	Now choose the Level TROLL 100 log file(s) you wish to correct  6.	
(shown automatically when in the proper location). 

You may check •	 R as many files as you like. For best results the 
time stamps in the BaroTROLL 100 log and the Level TROLL 
100 log(s) should overlap. (Baro Merge will use the first and 
last barometric values for Level TROLL data points beyond the 
barometric data time stamps.)

	Click OK 7.	  . The barometric compensation is applied. 
When processing is complete, click OK again.

	Click 8.	   to close Baro Merge. 

	The compensated log files may be viewed or exported from the •	
Data tab in Win-Situ. The original Level TROLL 100 log file is not 
changed.  A corrected log file with the same name and path is 
created with the file extension “–BaroMerge.wsl.” 
For more information, refer to the Win-Situ Baro Merge Technical •	
Note at www.in-situ.com.

Warranty ProvisionsA.	
In-Situ Inc. warrants the Level TROLL 100 and 200 and BaroTROLL 100 for one 
(1) year from date of purchase against defects in materials and workmanship 
under normal operating conditions. To exercise this warranty, contact Technical 
Support at the phone or e-mail address below for a return material authorization 
(RMA) and instructions. Complete warranty provisions are posted on our web 
site at www.In-Situ.com.

How to Contact UsB.	
Technical Support:	 800 446 7488
	 Toll-free 24 hours a day in the U.S. and Canada
Mailing/Shipping Address:	 In-Situ Inc.
		  221 East Lincoln Ave.
		  Fort Collins, CO 80524
		  USA
Phone:	 970 498 1500
Fax:		  970 498 1598
Internet:	 www.in-situ.com
E-mail:	 support@in-situ.com

To Obtain Repair Service (U.S.)C.	
If you suspect that your Level TROLL 100 is malfunctioning and repair is re
quired, you can help assure efficient servicing by following these guidelines: 

Call or e-mail In-Situ Technical Support (support@in-situ.com). Have the •	
product model and serial number handy.
Be prepared to describe the problem, including how the instrument was being •	
used and the conditions noted at the time of the malfunction. 
If Technical Support determines that service is needed, they will ask that your •	
company pre-approve a specified dollar amount for repair charges. When 
the pre-approval is received, Technical Support will assign an RMA (Return 
Material Authorization) number.
Clean the instrument and/or cable. Decontaminate thoroughly if it has been •	
used in a toxic or hazardous environment.  
Carefully pack your instrument and/or cable in a suitable shipping box. •	
Mark the RMA number clearly on the outside of the box with a marker or •	
label.
Send the package, shipping prepaid, to ATTN: Repairs at the address above.•	

The warranty does not cover damage during transit. We recommend the 
customer insure all shipments. Warranty repairs will be shipped back prepaid.

Outside the U.S.D.	
Contact your international In-Situ distributor for repair and service information.
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Operational Temp. Range -20°C to 50° C (-4°F to 122° F)

Storage Temp. Range -40°C to 80° C (-40°F to 176° F)

Diameter 1.03 in (26.2 mm) OD

Length 5.5 in (14.0 cm)

Weight 0.33 lb (0.15 Kg)

Material ABS

Output connection USB or RS232

Power 3.6 V lithium internal battery

Level TROLL Battery Life 5 years or 2 million readings

Memory 0.5 MB—Level TROLL 100

1.0 MB—Level TROLL 200, BaroTROLL 
100

Data Records 32,000—Level TROLL 100

50,000—Level TROLL 200

Fastest Logging Rate 1 per sec

Log Types Linear, Fast Linear, Event

Suspension Cable (for use with a 
backshell hanger and Level TROLL 
100 or 200)

Poly-coated 304 stainless steel 
50 ft, 150 ft, 300 ft

Cable (Level TROLL 200 only) 24/4 AWG

RS485 with connector, 
RS485 stripped and tinned, or 
SDI-12 stripped and tinned

BaroTROLL 100 Range: 7 to 30 psia (0.5 to 2 bar, 0.5 to 
2 atm, 14.25 to 61 in Hg) 

Docking Station  
(Level TROLL 100 and 200)

USB or RS232

TROLL Com  
(Level TROLL 200 only)

USB or RS232 for RS485 
communications via RS485 cable with 
connector

Level TROLL 100 and 200 Specifications

Minimum System Requirements 

Win-Situ 5: 400 MHz Pentium® II processor; 128 MB RAM, 100 MB free disk 
space; Internet Explorer® 6.01 or higher; Windows® 2000 Professional SP4 or 
higher, Windows XP Professional SP2 or higher, or Windows Vista; CD-ROM drive; 
RS232 serial port or USB port

Win-Situ Mobile: RuggedReader® with Microsoft Windows Mobile® operating 
system (Yellow RuggedReader, Pocket PC 2003 or later; Blue RuggedReader, 
Windows Mobile 5 or later), at least 16 MB data storage memory (SD/CF card or 
built-in non-volatile memory), Microsoft® ActiveSync® v. 4.5 or higher for Windows 
2000/Windows XP 

Pressure Sensor  (Non-Vented) Piezoresistive

	 Material Ceramic

	 Calibrated temperature 0° to 50° C

	 Accuracy @ 15° Typical ± 0.1% FS

	 Accuracy Full Scale Maximum ± 0.3% FS

	 Resolution ± 0.01 or better

	 Range 0-30 ft, 0-9.0 m 
0-100 ft, 0-30 m 
0-250 ft, 0-76 m

	 Burst pressure 0-30 ft: 60 ft, 18 m 
0-100 ft: 134 ft, 40.8 m 
0-250 ft: 368 ft, 112 m

	 Units of measure 
		  Pressure 
		  Level

 
psi, kPa, bar, mbar, mm Hg, 
ft, in, m, cm, mm

Temperature Sensor Silicon

	 Accuracy ± 0.3° C

	 Resolution 0.01° C or better

	 Units of measure Celsius, Fahrenheit



Information is subject to change without notice. In-Situ and the In-Situ Inc. logo, Win-Situ, TROLL, BaroTROLL, RuggedReader, RuggedCable, and Baro Merge are 
trademarks or registered trademarks of In-Situ Inc., Fort Collins, CO, USA. Microsoft, Windows, Excel, Internet Explorer, Windows Mobile, Windows Vista, and ActiveSync are 
trademarks or registered trademarks of Microsoft Corporation, USA and other countries. Pentium is a registered trademark of Intel. Copyright © 2008-2009 by In-Situ Inc.  
All rights reserved.
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Declaration of Conformity 
 
Manufacturer: In-Situ, Inc. 

 221 East Lincoln Avenue 
 Fort Collins, CO 80524 
 USA 
 
Declares that the following product: 
 
Product name:  Level TROLL  
Model:  Level TROLL 100 
Product Description: The Level TROLL measures and logs level and temperature in natural 

groundwater and surface water.  
 
is in compliance with the following Directives: 
 
 89/336/EEC for Electromagnetic Compatibility (EMC) Directive 
 73/23/EEC for Safety Directive 
 
and meets or exceeds the following international requirements and compliance standards: 
 

• Immunity  
 EN 61326:1997, Including Amendments A1:1998, A2:2001, A3:2003, 

Electric Equipment for Measurement, Control and Laboratory Use  
 

• Emissions  
 Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control 

and Laboratory Use 
 
Supplementary Information: 
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE 
mark is affixed accordingly. 
 

 
Bob Blythe 
President and CEO 
In-Situ Inc. 
November 12, 2007 
 

Declaration of Conformity 

Manufacturer: In-Situ, Inc. 
221 East Lincoln Avenue 
Fort Collins, CO 80524 

 USA 

Declares that the following product: 

Product name:  Level TROLL  
Model:  Level TROLL 200 
Product Description: The Level TROLL measures and logs level and temperature in natural 

groundwater and surface water.  

is in compliance with the following Directives: 

89/336/EEC for Electromagnetic Compatibility (EMC) Directive 
73/23/EEC for Safety Directive 

and meets or exceeds the following international requirements and compliance standards: 

• Immunity
EN 61326:1997, Including Amendments A1:1998, A2:2001, A3:2003, 
Electric Equipment for Measurement, Control and Laboratory Use  

• Emissions
Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control 
and Laboratory Use 

Supplementary Information: 
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE 
mark is affixed accordingly. 

Bob Blythe 
President and CEO 
In-Situ Inc. 
May 27, 2009 
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